How to use the LMS (Learning
Management System) by student
Access LMS

To access the SIS or self-service, visit the AC- Kuwait website and click on SIS link as indicated
in below snap:

’
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Logging In

In order to access most of the LMS features, you must log in.

1. On the Login window, enter your Username.

2. Enter your Password. If You Forget Your Password, refer to IT department to reset or
provide a new password.

3. Press OK.

Connecting to splms.ac-kuwait.edu.kw.

ser name

Password

Domain: AC-KUWAIT




LMS Home Page

After logged in, you get the below LMS home page:

Mohamad Rabee O. Obeid~ &% 2

BROWSE  PAGE Qs fyrouow s o7 O
ALGCONQUIN & Algonquin College esch the ste )
COLLEGE | Kuwent

ssawsasmsnssates. Algonquin College Of Kuwait Home

Recent

urses you are managing

Calendar

There are no items to display

ements

Welcome to the Algonquin College — Kuwait

Learning Management System (LMS).

The LMS is your communication gateway with the College and your instructors and classmates. Through the LMS, you can send and receive||
messages, start or participate in class discussions, access College announcements, or obtain valuable information about your courses,classes,and| |
classrooms

Access the course

Select the course you want to work on from the “course you are studying” on the right side of
the window:

SharePoint Mohamad fabee 0. Obeidv €3 2

mowss  paGe Qewe fyrouon s O

ALGCNQUIN « oacch this o
COLLEGE | ruman

Sauniontheitig AIQOhduin College Of Kuwait Home

Recent

Welcome to the Algonquin College - Kuwait
Learning Management System (LMS).

The LMS is your communication gateway with the College and your instructors and classmates. Through the LMS, you can send and receive
messages, start or participate in class discussions, access College announcements, or obtain valuable information about your
courses,classes,and classrooms.
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Course Home Page

The Course Home page is displayed when a user clicks a link of a necessary course on the
SharePoint LMS Organization Home Page.

SharePoint Teacher1l- £X
BROWSE ~ PAGE  PUBLISH ) SHARE 1 FOLLOW # EDIT
| Coursel Home Marketing Site Search this site o

egELEARNINGFORCE C ou rsel

- Welcome to SharePoint LMS Course @
wf Announcements .
I Calencr SharePoint

SharePoint Learning Suite

Tools

r Documents

) : You are looking at the front page of your newly created course
# Discussion Board

To change this course description press edit button in the ribbon area -’3‘\::@ nments
& Chat
Announcements Status Assignment Leamer Due Status
= Mailbox P
There are no items to show in this view of the "Announcements” list. To add a Active 6 = A2 (6)
&, Links new item, click "New". Ready To Review 0
o Overdue 0
o Plagiarism oA ) Closed g
. Add new item Due Today 6
Reports - Y
M Rep Due This Week 6
& Learning Path Due Next Week 0
All Assi t 14
Quizzes Calendar I fesgnments
33 Drop Box 'I;?::"are currently no upcoming events. To add a new event, click "Add new D rop Box
[ Assignments —
§ Attendance db Add new event Doc 2
B Conference Doc for Plagiarism check
= Gra o . 4k Add new item
§¥] Grade Book Mailbox A
2) Help Subject
[} Tracking Additional materials Learners
& Wiki Pages Your Test Results Assistant 2
43 Seating Chart Your Test Results Learner 1
@ Leamers & Groups First Assignment Learner 2
g Staff Your Test Results Learner 3
4k Add new item 4 Add new user
¥ Roster

The Course Home page displays general description of a course and gives a user an access to
the basic modules of the course. To access the course modules, click a corresponding icon on
the Course Tools menu:

Name Description
Announcements Allows managing course announcements
Calendar Allows posting events to notify other users
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Documents
Learning Path
Links

Quizzes

Drop Box
Plagiarism
Assignments
Attendance
Discussion Board
Chat
Conference
Grade Book
Tracking

Wiki Page Library
Seating Chart
Reports

Mailbox
Learners &
Groups
Staff
Roster
Help

Allows working with course documents

Allows managing course learning paths

Allows managing course links

Allows managing course quizzes

Allows managing files for shared usage

Allows checking items for plagiarism

Allows setting course home tasks

Allows registering student’s attendance

Brings users to the course forum

Brings users to the course chat room

Allows entering Online Video Conference

Allows setting grades for course students

Allows tracking statistics within course modules

Allows creating documents users want to share with other course members
Allows creating a class seating chart

Allows scheduling report on attendance and time spent by learners in each
course section

Allows managing message sharing

Allows managing the membership of course groups

Contains information about course teachers, administrators, faculty staff etc.
Contains information about course learners
Displays online SharePoint LMS documentation



Announcements

Announcements are intended for informational purposes: a user who needs to share some
important messages with others should create an announcement that will be viewed by all
course participants (Learners and a Teacher). The information will be displayed on the Home
Page as well as on the Course Home page (if other is not specified by the Course Home page
settings).

To get to the Announcements section, enter the necessary course and click the
Announcement icon in the left Tools menu. The list of available announcements will be shown
in the main workspace area:

# Coursel Home Marketing Site

Tools |:| B T Start Date Modified
W Announcements Announcement /82013 7/22/2013 4:37 PM
[E Calendar Announcement? 7/29/2013 7/22/2013 432 PM
0 Documents 4k Add new announcement

The home page of this section displays the current month announcements list with a possibility
of their editing and deleting. To work with an announcement, move the mouse over the name of
the announcement, click on the triangle and select the necessary option form the context menu.

NOTE: For better representation, you can change the list view. From the View list, select the
necessary view (select Current to view up-to-date announcements, select All to view all
announcements).

Column names at the top of the list are clickable and allow you to sort announcements in
ascending or descending order:

e Use the Title link to sort or filter announcements by title;

o Use the Madified link to sort or filter announcements by modification date;

e To remove filter criteria, click the necessary link in the column head, and then select the
Clear filter option from the context menu.

The Actions and Settings buttons on the List tab allow performing actions and operations
typical for SharePoint.



Adding Announcements

To create a new announcement, do the following:

1. Enter the necessary course;
2. Go to the Announcements section;
3. On the Items tab, click the New item button:

BROWSE ITEMS LIST
—I Wersion History
— Shared With
MNew Mew Wiew Edit Attach Alert
Item .  Folder Item Item Delete em File e .
Mew Hem anage Actions | Share 8 Track
1= Add a mew item to this list
Tools B & e
## Announcemenits Llectures mwow
FE Calendar Attention, please! mwew



4. Fill out the open form (fields marked with an asterisk are required to be filled):

BROWSE ECIT

| I E ol ,x Cut |-| I ABC
-l EEI Copy — \/
Zave  Cancel Paste .ﬁ.t_lg.lach Spelling
Fil= .

-

Commit Clipboard Actions | Spelling
ools

Title * Course teachers
w# Announcements

Body

%) Calendar We are glad to introduce new course teachers - Mr. Smith and Mr.

lohnson,
m Documents
¢ Discussion Board
@ Chat
iz Mailbox
&, Links
my Plagiarism
[7] Reports
2 Learning Path
[%5] Quizzes
23 Drop Box Start Date * 771772013 il

Keywords

e - .
£ Assignments Expires _—.

g Attendance
.ﬂ Conference Save Cancel

Fig. ‘Announcement creation form’

— Title — type the name of the new announcement (the field is required).

— Body - type the full information of the announcement. Use the embedded Visual Editor to
format the description text.

— Keywords — specify words which will help learners find necessary documents (keywords
should be entered in the site search field at the top of the page).

— Start Date- Specify the date from when the announcement will be valid. If the start date is
not specified, the announcement will become visible after you save the changes).

— Expires— Specify the date for the announcement to become invalid. If the date is not
specified, the announcement will be available for an indefinite period of time.

5. If you want to attach a file to the announcement, click Attach File, and then browse the
necessary file in the opened form. Click Save to attach the file.
6. Click Save at the bottom of the form to add the announcement.



Viewing Announcements

To view an announcement, do the following:

1. On the Course level, go to the Announcements.
2. Select the announcement you want to view and click the down arrow to open the drop-

down menu:
|:| @  Tite Start Date Modified
[ Course teachers © e » 71772013 TA7/2013 3:08 PM
Lectures @wew T 4]:} TAT/2013 71742013 3:.01 PM
H 1 3 HEV 7 2 el o
Attention, please! Edit Ttem 7M16/2013 7162013 5:23 PM

db Add new announcement
Compliance Details

Workflows

Alert me

Shared With

Delete Item

Fig. ‘Viewing Announcement’

3. Select View Item in the drop-down list. A new page with the announcement will open:
Fig.
Title Course teachers

Body We are glad to introduce new course teachers - Mr. Smith

and Mr. Johnson,

Keywords

Start Date 1772013

Expires

Created at 7/17/2013 3:08 PM by [ Teacher 1 CID:E """""
Last modified at 7/17/2013 3:08 PM by | Teacher 1 e = :

‘Announcement view form’

The ribbon of the dialogue box comprises the rest of the menu options for managing the
announcement. The ribbon top buttons allow users to perform the following operations:



4.

Editing the announcement - click Edit Item to modify the announcement.

Viewing the announcement version history - click Version History to view the history of
the changes made to the announcement and/or view the previous versions.

Managing permissions - click Manage Permissions to assign users and group
permissions to this item.

Deleting items - click Delete Item to delete the announcement.

Making notifications - click Alert Me to manage notification settings.

Click Close.

Editing Announcements

To edit the announcement, do the following:

1.
2.

3.
4.

5.
6.

On the Course level, go to the Announcements.

Specify the announcement you want to edit by placing the cursor on the announcement
name.

Click the down arrow to the right of the necessary announcement to open the drop-down
menu.

Select Edit in the drop-down list.

Modify the necessary fields.

Click Save to save the changes.

Deleting Announcements

To delete an announcement, do the following:

1.

2.
3.

Click the down arrow to the right of the necessary announcement to open the drop-down
menu.

Select Delete Item from the list.

Confirm the deletion. The item will be sent to Recycle Bin of the site.
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Documents

Document Home Page

The Documents section of the system allows you to create a repository of files that can be

downloaded or viewed online by your learners.

To work with course documents, enter the course and click the Documents link in the left Tools
menu. The system will display a list of course folders and documents organized as a tree
structure. Each folder or document in the list is characterized by its type, name when it was

modified, person who last made changes to the document and description.

SharePoint

BROWSE | FILES LIBRARY

#) Coursel Home Marketing Site

Documents o

SELEARNINGFORCE

Tools B type Mame Description Modified
wf Announcements Folder for new topic description text  7/22/2013 5:18 PM
[E Calendar .5 tasks 7/22/2013 5:36 PM
o Documents B List 7/25/2013 2:54 PM
® Discussion Board 'H new 7/22/2013 5:26 PM

11

Teacher 1
Teacher 1
Teacher 1
Teacher 1

Teacher 1~ £

) SHARE Yy FoLLlOw g synC

Search this site

Approval Status
Approved
Approved
Approved
Approved

L

Scheduling Approval

In Progress
In Progress

In Progress



View/Download a document

Method 1:

1. Enter the necessary course.

2. Inthe left Tools menu, click Documents. The list of available documents will be shown in
the main workspace area.

3. Click the name of the necessary document,

(Gnsses Documents «

W s u ’ 2

€

rAaEBEs S

The system will either display the document or offer it for downloading at the bottom of the
window as attached below:

SharePoint
BROWSE | FILES  LIBRARY

(Dms3es

ACC2222 LECT CO10 Financial Information-SPRING 2017 Home

Documents o

Tools @ new document or drag files here
¥ Announcements All Documents  Approve/reject ltems My submissions ~ =++ Find a file 0o

[ Calendar
v [ Neme Description Modified Modified By Approval Status  Scheduling Approval
{4 Documents
. Start Creative Cloud Packager and choose Creative Cloud for education wes  test February 15,2018 | Mohamad Rabee O. Obeid Approved In Progress
® Discussion Board
@ Chat
& Mailbox
&, Links
[&] Reports
&, Learning Module
Quizzes
23 Drop Box
[ Assignments
& Attendance
[B) conference
Grade Book
7) Help
g Tracking
&) Wiki Pages
88 Seating Chart
€8 Leamers & Groups
g staff
¥ Roster

Site Contents

B Start Creative Clo...docx ™
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4. Show the file in folder or open it.

g4 Staff
¥ Roster Open
Site Contents Always apen files of this type

Show in folder

@ Start Creative Clo...docx ™

Method 2:

1. Enter the necessary course.
2. Inthe left Tools menu, click Documents. The list of available documents will be shown in

the main workspace area.
3. Click on the three dots at the end of the file name then choose “Download a copy” as
attached below:

QM5 Documents o

(® new document or drag files here

The system will either display the document or offer it for downloading at the bottom of the
window as attached below:
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SharePoi
BROWSE | FILES  LIBRARY

@L“Ao§p?;93 Documents o

ACC2222 LECT CO10 Financial Information-SPRING 2017 Home

Tools @ new document or drag files here

@ Amnouncements Al Documents  Approvereect tems My submissons -+

[ calendar
v [0 Name Description Modified Modified By Approval Status  Scheduling Approval
£ Documents
Start Creative Cloud Packager and choose Creative Cloud for education wes  test February 15,2018 | Mohamad Rabee O. Obeid Approved In Pragress
# Discussion Board
@ Chat
& Mailbox
@, Links
Reports
& Leaming Madule
Quizzes
33 Drop Box
[F Assignments
& attendance
B conference
Grade Book
2) Help
g Tracking
&) Wiki Pages
#4 Seating Chart
8 Leamers & Groups

g staff
q Roster

Site Contents

B Start Creative Clo...docx  ~

4. Show the file in folder or open it.

85 Staff
¥ Roster Cpen
Site Contents Always apen files of this type

Show in folder

Cancel

@ Start Creative Clo...docx,
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Method 3:

Repeat the above steps using the Files and Library tabs at the top allow performing actions
and operations typical for SharePoint like view or download the files.

SharePoint

® cument or drag files h

D \pproversject tems My submissions -+ da e o
PR
B 55 st creatie Cloud Packagerand choose Creative Cloud foreducation [ test Februny 15,2013 Mohamad Rabee 0. Cbeid Approved In Progees

@ sancrestive Clo..dooe & @ stan Crestive Clo...doce ~ Showall X
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Mailbox

The Mailbox option allows you to send and receive e-mail messages.

To work with the mailbox, enter the necessary course and click the Mailbox icon in the left
Tools menu. The system will show contents of your mailbox:

BROWSE | ITEMS LIST |

¥ Coursel Home Marketing Site

\L"’ELEAHNINGFDRCE I\/Ia”box

Tools [l 0 subject
w Announcements Additional materials Learner 1 Teacher 1
- Assistant 1
[ Calendar ssistan
Your Test Results Teacher 1 Learner 4

my Documents

TIP: For better representation, you can modify the list view. From the View list select what
messages should be visible: all (my items), sent or received.

Column names at the top of the list are clickable and allow you to sort messages in ascending
or descending order. In addition, you can filter messages by various criteria:

= Click the Subject, Created, From or To links and select the required value (all
messages that do not match the selected criteria will be hidden);
= Use the attachment column link to display messages with or without attachments

only.
=  To remove filter criteria, choose the necessary link and select Clear filter from option.

The Actions and Settings buttons at the top of the list allows performing actions and operations
typical for SharePoint.

To preview a mailbox message, click its name in the list.
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BROWSE VIEW

. Wersion History Alert Me
E= T : .
&% Shared With & Wordlows

Reply Edit
Iter % Delete Item
Manage Actions
Tools i

Subject Your Test Results

@ Annocuncements
To Learner 1

FrE] Calendar
Messzage Dear Lerner,

oy Documents

: . Your test results are perfect!

® Discussion Board P
Chat

- Created at 7/24/2013 11:58 AM byl | Teacher 1

iz Mailbox Last modified at 7/24/2013 11:58 AM by [ | Teacher 1

Close

Buttons at the top of the message allow performing the following operations:
Click Reply to answer a letter;

Click Edit Item to modify the message;

Click Delete Item to move the message to the Recycle Bin;

Click Alert Me to work with notification settings.

To close the message and go back to the mailbox, click Close.

17



Viewing Mailbox

To view the mailbox, do the following:

1. On the course level, go to Course Tools > Mailbox;
2. Once you have done it, the Mailbox items list will appear:

¥ Coursel Home Marketing Site Search this site
Mailbox o
D 7} Subject send Ema ation
Additional materials Learner 1 Teacher 1 7/24/2013 1:12 PM Completed
Assistant 1
Your Test Results Teacher 1 Learner 4 7/24/2013 12:50 PM Completed
Your Test Results Teacher 1 Learner 2 7/24/2013 12:49 PM Completed
Learner 3
First Assignment Learner 1 Teacher 1 7/24/2013 12:16 PM Completed
Your Test Results Teacher 1 Learner 1 7/24/2013 11:38 AM Completed

db Add new item

By default, the Mailbox items list will show both sent and received item. To change the view of
the Mailbox items list, do the following:

On the course level, go to Course Tools > Mailbox;

Once you have done it, the Mailbox items list will appear;

On the ribbon, go to the List menu;

Go to Manage Views section, open My Items drop down and select the needed view:

PR
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BROWSE ‘ ITEMS LIST |

— ['“; Modify View . Current Visw:

[} Creste Column My iterns -
View Oéi;l: Creste
it View Mavigate Up Default
View Format Manage Vi5 by irems
Public
Tools
Read
#f Annocuncements Received
[E] Calendar Replied
Sent
o Documents
Unread
g .
Discussion Board Unreplisd

@ Chat

. gk Add it
& Mailbox new item

Y ™ [ Open with Access w
€ — N I !
P— ")@ Open with Project
Tags & E-mailz  Alet RSS Connect to Export to Customize
Motes Link Me . Feed Ourtlook cncel Form
Tags and Motes Share & Track Connect & Export g
=a From To
r Test Results o new Teacher 1 Learner 4
r Test Results o wew Teacher 1 Learner 2
Learner 3
Assignment @ new Learner 1 Teacher 1
r Test Results mnew Teacher 1 Learner 1

Received items — displays all messages that have been received by the user. To view

the received items only, select Received from the drop down. The Received items list

will appear:

SharePoint Teacher 1~ ¥

BROWSE ITEMS LIST f:.l SHARE 'ii"f FOLLOW
J 7 - Current View: =1 E-mail a Link aj‘ F
-
Al
)] Received - Alert Me - © A 1
Wiew  Quick Create Tags & Connect & Customize Settings
Edit View Current Page Motes RSS Feed Export - List - -
View Format Manage Views Tags and Motes Share & Track
) 0 subject From Created

HEW

RE: Your Test Results &
Home Task questions £ new
My Course Work = new

gk Add new item

Learner 2

Learner 4

Learner 4

8/6/2013 342 PM
8/6/2013 2:25 PM

8/6/2013 3:24 PM

Read items — displays all messages that have been read by the user. To view the read

items only, select Read from the drop down. The Read items list will appear:
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SharePoint Teacher 1~ $F

BROWSE ITEMS LIST tf:.l SHARE ﬂg FOLLOW
\J 7 - Current View: 21 E-mail a Link Eﬂ L—\ F
3
M | Read - Alert Me - ) 2 1+
View  Quick Create Tags & Connect & Customize Settings
Edit View Current Page Motes RS55 Feed Export~  List~ -
View Format Manage Views Tags and Motes Share & Track
] 0 subject From To Created
RE: Home Task questions = new Teacher 1 Learner 4 8/5,/2013 339 PM
Your Test Results fwew Teacher 1 Learner 3 8/6/2013 330 PM
Learner 4
Your Test Results @ new Teacher 1 Learner 2 &/6/2013 3:29 PM
Your Test Results wew Teacher 1 Learner 1 8/6/2013 3:29 PM
[Cm Home Task questions & new Learner 4 Teacher 1 8/6/2013 325 PM

gk Add new item

NOTE: Itis impossible to mark the message as unread.

All Received Messages are marked as Read (' ! ) and Unread ( ) with the corresponding
icon.

Column Read have filter that allow the user to filter the messages by Read/Unread.

o Sent items - displays all messages that have been sent by the user. To view the sent
items only, select Sent from the drop-down menu. The Sent items list will appear:

20



SharePoint Teacher 1~ %

BROWSE ITEMS LIST

J |:,- » Current View: =1 E-mail a Link

o i e
Sent - Alert Me - @ *ﬁ *
View  Quick Create

Edi

; Tags & Connect & Customize Settings
dit View Current Page MNotes RSS Feed Export ~ List -

) SHARE <y FOLLOW

View Format Manage Views Tags and Motes Share & Track
[l 0 subject From To Created
RE: Your Test Results & new Learner 2 Teacher 1 8/68/2013 3:42 PM
My Course Work =2 new Learner 4 Teacher 1 8/6/2013 3:24 PM
dp Add new tem
NOTE: )
All Messages sent by user are marked as Sent ( = ) with the corresponding icon.
[ )

Replied items - displays all messages that have been answered by the user. To view
the replied items only, select Replied from the drop-down menu. The Replied items list

will appear:
SharePoint Teacher 1= %
BROWSE | ITEMS | LST €y SHARE ¥ FOLLOW

J |:..- - Current View: =1 E-mail a Link

W 4 D
Replied . Alert Me - & I:*"ﬁ 2
View  Quick Create

I : Tags & Connect & Customize Settings
Edit View Current Page Motes RSS Feed Export - List = -
View Format Manage Views Tags and Notes Share & Track
| @ subject Fram To Created
[ Home Task questions & new Learner 4 Teacher 1 8/6/2013 3:25 PM

g Add new item

NOTE: Once the user sends a reply to the message, the icon of the messages changes to “Replied”. All

Replied Messages are marked as Replied (™ ) with the corresponding icon.
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Replied Messages are marked as Received and Read accordingly for the addressee.

Messages can be filtered by the Replied/Unreplied status in the Replied Column:

SharePoint Newsfeed  SkyDr
BROWSE | ITEMS  LIST
& Course 1 Home Search this site R
Mailbox e
0 D subject From To Created Send Email Motification
» My Course Work Learner 4 Teacher 1 8/6/2013 3:24 PM  Completed Learner 4 Teacher 1
Teacher 1
C] Home Task questions Learner 4 Teacher 1 8/6/2013 3:25 PM  Completed Learner 4 [ | Teacher 1
Teacher 1
Your Test Results Teacher 1 Learner 1 8/6/2013 3:29 PM  Completed Teacher 1

NOTE: As in existing aggregated SharePoint LMS web parts, Mailbox web part has the Disable Cache
property. If the property is checked cache in the web part will be disabled. If the property is
unchecked data that is shown in the web part will be cached with cache timeout of 10 minutes.

Sending Messages

If you want to send a message to another system user:

1. Enter the necessary course

2. Click the Mailbox link in the Course Tools menu. The system will display contents of
your mailbox.

3. Click New Item above the list of messages. The following form will be opened:
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BROWSE  EDIT
E e, K Cut s ABC
H | Fycopy L v
Zave  Cancel Pazte At'_t_fch Spedling
rile -
Commit Clipboard Actions | Spelling
Tools - e
Subject Your Test Results
wé) Announcements Message subject
Calendar *
E Tao Learner 1 x
0y Documenis User(s) who this message will be send to
¢ Discussion Board Message
& Chat
] Dear Lerner,
=1 Mailbox
& Links Your test results are perfect!
L
oy Plagiarism
. Message body
1] Reports

2 Learming Path
[72] Quizzes

Save Cancel

4. Fill out the form fields as described in below (fields marked with an asterisk are required
to be filled out):

— Subject — Enter the subject of the message
— To - Enter the user for whom the message is intended. To check whether this

user exists in the system, click the Check Names icon ( 9‘-/). If a user with this
name does not exist, the system will display a red error message. If you do not
know exact name of the user for whom the message is intended, click the

Browse icon ('M) and search for the necessary user, select Learners or
Teachers depended on whom you want to send to.

Double click on the person name, or click the person name and then click on
Add button and once finished, click OK as shown below:
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Select People

Search

Learners

5.

Teachers

Teaching Assistants

Faculty

Show all learners on course

All Search

Results

IE Leamers

Display Mame
Abdulaziz 1. AlRumaih

Abdulaziz M. AlMutairi
Abdulaziz M. AlEnezi
Abdullah B. AlFahad
Abdulwahab Boresli
Afrah 5. Alkhaldi
Ahmad AlShallal

Ali M. Mohammed

Ali Y. Chaudhry
Anwar 5. Alagymi
Athra alsteyah

4

Add -=

Mohamad Rabee O, Obeid;

If you want to attach a file to the message, click the Attach file button in the top left

Message — Enter the text of the massage. Use the embedded editor to format the

text.

E-mail Address
2016-00252 @ac-kuwait.edu

2015-00054@ac-kuwait.edu
2015-00062@ac-kuwait.edu
2016-00273@ac-kuwait.edu
2015-00141@ac-kuwait.edu
2015-00063 @ac-kuwait.edu
2016-00229@ac-kuwait.edu
2015-00253@ac-kuwait.edu
2015-00264@ac-kuwait.edu
2016-00271@ac-kuwait.edu
2015-00084@ac-kuwait.edu

3

0K

| | Cancel

corner and specify the path to the necessary file on your computer
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SharePoint

BROMWSE EDIT

Tools

Subject * | Your Test Results

wf) Announcements Message subjpect

[T Calendar To*

o Documents User(s) who this message will be send to

Leamer 1 x

& Dhscussion Board Message

@ Chat B 7 U

] Dear Lerner,
= Mailbox

& Links Your test results are perfect!
iy Plagiarism

[TT] Reports

& Learning Path

Quizrzes

Message body

Save Cancel

Click on Choose file button:

Use this page to add attachments to an item.

Mame

Choose File | Mo file chosen

OK Cancel
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Specify the location path and then select the desired file to attach and then click on Open

button:

€ Open

« = v 4 @ s This PC » Documents

Organize v Mew folder
Sharepaint Lyl Mame
fz Algonquin Colleg AutoCAD Sheet Sets

Customn Office Templates

@ OneDrive - Algon: Downloaded Installations

[ This PC My Data Sources
3D Objects My Shapes
I Desktop OneMote Notebooks
Outlook Files
@ Pocuments wansview_record
; Downloads dalivsall pilals
J! Music “'QAC.rdg
= Pictures 5. Default.rdp
m Videos @ Sudents.accdb

s Windows (C:)
- Local Disk (D)

The file will be added as below, click OK:

Use this page to add attachments to an item

Name

Choose File

Date modified

6/8/2016 10:20 AM

testaxlsx

Type

File folder
File folder
File folder
File falder
File folder
File folder
File folder
File folder
File folder
RDG File
Remote Desktop ...

Microsoft Access ...

QK

v | O Search Documents

Size

2KB
DKB
420 KB

Cancel

o @

Also, the file will appear in the new mailbox message window, you can delete it if you are not

sure about it, if confirmed, click Save:

Click for help about adding basic HTML formatting.

Message body

Attachments Chfakepath\testxlsx

E Delste

26
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After click Save, the message will be delivered, and it will be shown on the mailbox home
page as below:

Mailbox

(® new item or edit this list

My items  Read  Received e Find an item 0o
v 0 subject From To Crasted Send Email Motification
I excel Mohamad Rabee O. Obeid Mohamad Rabee O. Obeid October 22, 2018 Completed
test2 Mohamad Rabee ©. Obeid Mohamad Rabee Q. Obeid March &, 2018 Completed
Test Mohamad Rabee O. Obeid Mohamad Rabee O. Obeid March 6, 2018 Completed

6. Click Spelling to check spelling
7. When finished, click the Save to send out the message to the specified user; click
Cancel to discard changes and navigate back to the list of messages.
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Replying to a Message

To reply a message,

1. Enter the necessary course.

2. Click the Mailbox link in the Tools menu. The system will display contents of your
mailbox.

3. Click the name of the message you want to reply to.

4. Click the Reply button:

SharePoint

BROWSE WVIEW

| Version History Alert Me
S48 132 Shared with

Edit Reply
Ttem Delete Item
Manage Actions
Tools :
Subject Your Test Results
& Announcements
To Learner 1
[ Calendar
Message Dear Lerner,

i Documents

. : Your test results are perfect!
® Discussion Board

@ Chat Created at 7/24/2013 11:58 AM by [] Teacher1
Last modified at 7/24/2013 11:58 AM by L] Teacherl

Close
§=y Mailbox

5. Enter the text of the message. Note that you have the text of the original message included
into the text field to enable user to track the conversation.
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SharePaint Teacher 1~ £

BROWSE EDIT

H B

Save Cancel

Commit
Subject *

To ™

Message

6. Click Reply to save changes. Click Cancel to discard changes.

oy O Cut @D ABC
D E Copy V
Paste Attach  Spelling
File -
Clipboard Actions  Spelling

) SHARE Y7 FOLLOW

RE: My Course Work

Message subject

Learner 4:

=

User(s] who this message will be send to

&EE

From: i:0#.w|example'/4
Sent: 5/6/2013 3:24:08 PM
Subject: My Course Work
My Course Work

Click far help about adding basic HTML formatting.
Message body

Reply

Cancel
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Quizzes

View Quizzes

To view the list of current Quizzes, do the following:

1. Open the needed Course;

2. On the Tools menu select Quizzes. The list of current quizzes will appear:

¥ Coursel Home

ﬁ"‘-ELEAHNINGFORCE Q U IZZES ®

oot [ Create | Actions ~
wf Announcements
Mame Diescription Total Atternpts  Last Modified
[FE Calendar ui
uizzes
r Documents T
Quizl 3 19 hours ago
® Discussion Board .
Quiz 2 10 19 howrs ago
Chat . . . -
- Quiz 2 quiz description 17 19 howurs ago

The Quizzes page contains three sections: Quizzes, Surveys, and Questions Pools.

The Quizzes section contains a list of quizzes, the Surveys section contains a list of surveys,
and the Question Pools section contains a list of question pools.
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Start Answering the quiz

To start the created quiz, do the following:

1. Onthe course level, go to Course Tools>Quizzes;
2. Click the Quizzes icon;

3. The list of Quizzes, Surveys and Question Pools will appear. Select the needed quiz by
putting the cursor arrow on it:

Quizzes o

Actions -
MName Description Total Attempts  Last Modified
Quizzes
] iz 1 P 7 days ago
[ uiz 2 3 3 days ago
] iz *  guiz description 13 57 minutes ago
Surveys
[=] Surveyl Survey description 0 4 days ago

4. Click the drop-down arrow against the quiz name to open the Edit Content Block drop
down menu;

5. From the drop-down menu, select Start:
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Quizzes o

[ Create Actions -

Mame Description Total Atternpis  Last Madified
Quizzes
[ Quizl 2 7 days ago
2] Quiz2 3 3 days ago

[ Quiz 2 ’ quiz description 13 57 minutes ago
S Start {b

= Al Attempts Survey description 0 4 days ago

[# Settings

¥ Delete

6. Once you click Start, the quiz is on;

7. If you are allowed to take the attempt, the following message will appear: You are about
to begin n. attempt. Press NEXT to begin.

Quiz 3

You are about to begin 1. attempt. Press NEXT to begin
This quiz allows 3 attempt(s)

This quiz timeouts after 120 seconds

Mezt Cancel

The form specifies the number of attempts allowed.

NOTE:  |f the learner is not allowed to take an attempt, he sees a message: ‘You cannot start this quiz.

Out of attempts. This quiz allows n. attempt(s)’:
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Quiz 3

You cannot start this quiz. Out of attempts.
This quiz allows 3 attempt(s)

This quiz timecuts after 120 seconds

Cancel

Click Cancel button to omit the attempt. Once you click the button, you will see the All Attempts
list.

8. Once you click Next, the quiz form will appear:

Quiz 3

00:11 | Score: 0 out of 135 | Skipped: 3
Big Cities

List the cities in the ascending order from underpopulated to most
densely populated.

L |Moscow |=
2. | New York| >

3 Tﬂk'_,"Cl -

Clear

Question 11

Fill in the gap:

To be, or not to be: that is the I:IEI

Question 8
Specify synonyms to the word 'to like'
O to love

[ to be fond of
[ to hate

Created at 7/29/2013 1:59 PM by [ Teacher 1
Last modified at 7/2%/2013 1:5% PM by | Teacher 1

Previous Fimish Cancel

33



NOTE: Click Next to navigate between quiz question pages or just to skip some questions to finish
them later. Number of skipped questions will be displayed (Skipped: n.). Note please that
after clicking the Next or Previous buttons all answered questions will be saved and you will
not be able to change them anymore (the answering field will be inactive):

Quiz 3

00:14 | Score: 20 out of 135 | Skipped: 11
Q1

Select True. /
" False Clear

Q3

Select True,

i@ True ' False

Teacher 1
M by | Teacher 1

Mext Cancel

NOTE: When users answer Drop Down, True or False, Multiple Choice, Multiple Answer, Matching,
Gap Fill, Hot Spot questions they can uncheck the answers clicking the Clear button:

Question 3

Select Falss

@ Trus ) False Clear

Question 6
Find member of the EU.

Australia

i@ Germany

Canada

Clear
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Note please that after clicking the Next or Previous buttons all answered questions will be
saved (see previous NOTE).

9. Complete the quiz questions and click the Next button to proceed. The following form will
appear displaying user’s score, grade and number of skipped questions. Click the Finish
button to submit the quiz. Note please, that after submitting the quiz a user won’t be able
to answer skipped questions:

00:36 Skipped: 1

You finished this quiz.
Press Finish to leave.
Your grade is 83.467.

Review thizs attempt.

Created at 8/17/2012 5:04 PM by Learner 4 Enich
Last modified at 8/17/2012 5:04 PM by Learner 4

NOTE: To review the attempt, click the Review link:

Quiz 3

00:58 | Score: 115 out of 135 | Skipped: 0
You finished this quiz.
Press Finish to leave,

Your grade is B.

Rewview this attemnpt.

Teacher 1
v by | Teacher 1

Finish

The following form will appear:
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Score
115

Grade
B
Q1 15 Points Edit
Select True,
@ True [ False
Edit Comment
Question 10 10 Points Edit
How much s 0.5 + 5.0

5.5
Edit Commenit

Content Type: Attempt

ted at 7/29/2013 2:08 PM by [ Ti r
Created G.t.._ 20/2013 2 v by eacher 1 Cloze
L ast modified at 7/29/2013 2:09 PM by [ Teacher 1

After you have reviewed the quiz, click Close.

10. Click finish to see the All Attempts list.
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Assignments

View Assignments

The Assignments section allows users to set assignments within the course and view the
results of performing assignments.

To access the Assignments section, click the Assignments link on the Course Tools menu. The
Assignments section is represented as Assignment Calendar by default.

SharePoint Teacher 1= %X

BROWSE | ITEMS LIsT || CALENDAR | C" SHARE f_‘lf FOLLOW
. ? Coursel Home Marketing Site Search this site D
S ELEARNINGFORCE ;
Assignment Calendar o
" "
— ' € (% August 2013
Jan Feb Mar
Apr May Jun SUNDAY MONDAY TUESDAY WEDNESDAY  THURSDAY FRIDAY SATURDAY
4 —
Jul Aug Sep 28 29 30 31 1 2 3
Ot Nov  Dec
Today is Thursday, August 1,
2013
Tool 4 5 6 7 8 9 10
ools
@l Announcements
[EE] Calendar
5 " <
r Documents H = = 4 3 ® :
® Discussion Board
L] Chat
. i 5
& Mailbox 18 19 20 21 22 23 24
Essay
&, Links
Plagiarism
m Flag
T 25 26 27 28 29 30 31
7] Reports
& Learning Path
Quizzes

Assignment Calendar (the Calendar view) should be differentiated from the Assignment Tasks
(the All Tasks view) which can be accessed through the View Learner’s Assignments link
(available when moving the mouse cursor on the assignment name).
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SharePoint Teacher1- %3

) SHARE Yy FOLLOW

BROWSE | ITEMS LIsT |

. # Coursel Home Marketing Site Search this site D
SELEARNINGFORCE :
Assignment Calendar o
] s ) . - R e PR
Tools D L] - Tide Location Opening Date Due Date All Day Event
W Announcements Ad 74772013 5:00 PM 741472013 5:00 PM
[H Calendar A3 7/21/2013 5:00 PM 7/23/2013 5:00 PM
o Documents Al 77222013 1:00 PM 7/22/2013 5:00 PM
* Discussion Board A2 7/29/2013 5:00 PM 7/31/2013 5:00 PM

@ Chat Assignment @ 8/5/2013600PM  8/7/2013 6:00 PM
& Mailbox Essay o 8/19/2013 %00 AM  8/20/2013 6:00 PM
&, Links

& Add new item

Submit an Assignment

Note: If the due date is finished, you will not be able to submit the assignment.

If you want to submit an assignment to the instructor:

1. Enter the necessary course

2. Click the Assighment link in the Course Tools menu. The system will display all the
assignments assigned to you inside this course.

3. Click the assignment you want to submit.

4. Click on Edit Item from the view menu as shown below.

38



arePoil

BROWSE VIEW

Viersion History Alert Me

% Shared With & Workfiows
View Learnerg
Assignments

Actions
Tocls Template
Announcements
@ Title Test2
[ Calendar . . o
Assignment Type Online Submission
0 Documents
Opening Date 9/18/2019 2:00 PM
® Discussion Board
Due Date 9/30/2019 12:00 AM
Chat
= Clasing Date
= Mailbox e .
Description The questions are into the attched file.
&, Links
Reports Attachments testaulsk
2, Learning Module Group Hand In No
Quizzes Scale Configuration
23 Drop Box Assigned To Mohamad Rabee ©. Obeid
T Assignments Notify me when learners return tasks for this assignment Yes

gl Attendance

Content Type: Assignment
@ Conference Created at 9/19/2019 1:56 PM by [] Mohamad Rabee O. Obeid
Grade Book Last modified at 9/19/2019 2:01 PM by L] System Account

(2) Help
[ Tracking
& Wiki Pages

5. Put your answer inside the description box or you may attach file.

BROWSE DT
HB mr | X v
D Ey copy Q
Save  Cancel Paste View Leamer's Delets Spelling
Assignments [tem -
‘Commit Clipboard Actions Spelling
Tools
Template
wf) Announcements
Title * | Test?
[T Calendar
& Documents Assignment Type | Online Submission T |
# Discussion Board Opening Date * [a/13/2010 | B [2pm 7|
@ Chat The time that the assignment

becomes available to students.

Mailbox
-
& Lin Due Date [9s30/2019 | B [12am 7]
Inks
The due date for the assignment.
Reports Homework submitted after this time
will be marked overdue.

& Leamning Maodule

[¥5] Quizzes Closing Date | i | 128M ¥ |

The last date that the system will
allow submissions for this assignment.

123 Drop Box

[EE Assignments t to the Due Date.
& Attendance Description The questions are into the attched file. “{)
B conference

Grade Book

(2) Help
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If you attach file, follow the below steps:

Click on Choose file button:

Use this page to add attachments to an item

Mame

Choose File | Mo file chosen

OK Cancel

Specify the location path and then select the desired file to attach and then click on Open
button:

€ Open
« v P » ThisPC » Documents ] Search Documents
Organize Mew folder =~ [ @
~
Sharepoint " MName Date modified Type Size
> & Algonquin Colleg AutoCAD Sheet Sets 6/8/2016 10:20 AM  File folder
. Custom Office Templates 5/2/201910:23 AM  Filefolder
> @ OneDrive - Algon Downloaded Installations 5/5/20199:39 AM  File folder
w [ This PC My Data Sources 5/5/2019 %:39 AM File folder
> ZJ 3D Objects My Shapes 5/5/2019 %:39 AM File folder
» [ Desktop OneNote Motebooks 5/5/2019 9:39 AM File folder
' D Outlook Files 5/5/2019 G:40 AM File folder
> ts
peumen wansview_record 8/20/2019 1:23PM  File folder
> & Downloads daliwall ilils 11/18/201512:22 .. File folder
> b Music % ACrdg 7/17/2016 1229 PM  RDG File 2KB
» [&] Pictures . Defaultrdp 4/28/2019 11:20 AM  Remote Desktop ... 0 KB
> B Videos @ Sudents.accdb 9/3/201911:22 AM  Microsoft Access ... A20KB
> i Windows (C:)
> e Local Disk (D:)
5 e Netwnrk A
File name: v | A Files )
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The file will be added as below, click OK:

Use this page to adc attachments to an item.
Mame

Choose File | testxlsx

QK Cancel

Also, the file will appear in the new mailbox message window, you can delete it if you are not
sure about it, if confirmed, click Save:

Click for help about adding basic HTML formatting.

Attachments Chfakepathitestxlsy = Delete

If you are sure about the file and confirm everything is ok, click the Submit button.

Note: If you click the submit button to send the assignment, you will not be able to submit it
again.
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Discussion Board

The Discussion Board section allows a user to leave some messages so that other course
participants can react to these messages in some way and leave their opinion about them.

Discussion boards are created within the frames of separate courses. Only users who take part
in the course can view its discussion boards and add their own messages to them. To access
the course discussion board, enter the necessary course and click the Discussion Board icon
in the Course Tools menu.

SharePoint

.......

1 Coursel Home Marketing Site

S Discussion Board o

Tools
Discussion Board Description Ttems Last Modifiec

P i X . i . .

) Announcements Course Discussion Discussion Board for questions related to our course, 3 24 hours ac

[ Calendar Discussion Board 2 1 24 hours ag
r Documents 4 Add new discussion board

® Discussion Board
Fig. ‘Discussion Board section’
The Discussion Board tool has 3 levels:

» Discussion Board (contains categories to facilitate discussions filtering).
» Discussions (contains topics for discussion created inside discussion boards).
» Replies (discussion threads).

Adding Discussion to Discussion Board

To add a new discussion to the forum, do the following:

1. Enter the necessary course.

2. Onthe left Tools menu, click Discussion Board.

3. Click a discussion board name, and then click Add new discussion (%) and complete
the open form as described below:
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BROWSE EDIT FORMAT TEXT | INSERT

T S8 W an «

Table  Picture Embedded “ideo and Link Upload Embed

- - hedia - Audio - - ile Code
Tables Media Links Embed
Tools _
Subject | First Lecture

#f Annocuncements

[7] Calendar Body Yesturday we had the first lecture. I'd like to knew your cpinicn on
o Documents .
® Discussion Board

& Chat

iz Mailbox

&, Links
oy Plagiarism

[TT] Reports

&, Learning Path

Quizzes

3 Drop Box

Question |

I amn asking a question and want to get answers from other members.

Eave Cancel

) Assignments

— Subject — type the subject of the discussion (the field is required).

— Body — describe the topic of the discussion.

To attach a file, click the Attach File or Upload File link and browse the necessary
file. Click OK.

To check spelling, click the Spelling link.

4. Select and enable the box of Question as shown below.

Question |

| am asking a question and want to get answers from other members.

Created at 11/22/2017 9:43 AM by
Mohamad Rabee 0. Obeid

Save Cance

Last modified at 11/22/2017 943 AM by L] Mohamad Rabee O. Obeid

5. Click Save.
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Insert Audio or Video file into Discussion Board

To add audio or video file in a new discussion to the forum, do the following:

1. Enter the necessary course.
2. On the left Tools menu, click Discussion Board.
3. Choose either Start New Discussion or View Discussion Board.

Discussion Board o

Discussion Board Description
® new discussion board

blog1 are you happy

| Test -

Start Mew Discussion
View Discussion Board
E# Settings

K Delete

4. If you select View Discussion Board, click New Discussion as shown below:

(# new discussion

Recent My discussions  Unanswered questions ==

test33
management in alignment with the business plan.Algonguin College - KuwaitPosition SpecificationsPo...
By Mchamad Rabee Q. Obeid | February 15, 2018

test22
Position Overview Reporting to the President and serving as an integral member of the senior manage...
By Mchamad Rabee Q. Obeid | February 15, 2018

Test
By Mchamad Rabee O, Obeid | Movember 22, 2017

If you click Start New Discussion, you will get the following window:
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Subject *

Body

Cuestion

My Trip

vl

| am asking a question and want to get answers from other members.
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Click inside the Body box in order to have the Insert menu commands at the top of the window:

SharePoint

BROWSE EDIT | FORMAT TEXT | INSERT |

oy

£ E(’Eié?*

<>

Embed
Code

Table Ficture Wyideo and
udic )

Tables Me From Gomputer kS Embed

Embed

Tools From SharePoint Subject *

&) ANNoU| From Address

[ Calendar

My Trip

Body

& Documents

® Discussion Board
@ Chat
=3 Mailbox

&) Links

Reports

& Learning Module

Quizzes Question |

. | am asking a question and want to get answers from other members,
53 Drop Box
FFE| Assignments ‘ Save ‘ ‘ Cance |

g§d Attendance

3 conference

Click Choose File button:

Upload Media

Choose a file Choose File | Mo file chosen

[#] Overwrite existing files

Destination Library Site Assets

OK Cance
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Locate the path of the audio or video file, select it then click Open button:

¢ Open
« - 1 » ThisPC » Documents v O Search Documents =]
Organize v New folder B @ @
Sharepoint CJ Name Date modified Type Size
¥Yp
B Algonquin Colleg AutoCAD Sheet Sets /872016 10:20 AM File folder
. Custom Office Templates 5/2/2019 10:23 AM File folder
@ OneDrive - Algon Downloaded Installations 5/5/20199:39 AM  File folder
[ This PC My Data Sources 5/3/2019 9:39 AM File folder
8 3D Objects My Shapes 3/3/2019 %:39 AM File folder
I Desktop OneNote Notebooks 5/3/2019 %:39 AM File folder
- Qutlook Files 3/3/2019 %:40 AM File folder
ts
oeumen wansview_record 8/29/20191:23PM  File folder
& Downloads dalivall yilals 11/18/201512:22 ... File folder
b Music % AC.rdg 7/17/201612:29PM  RDG File 2KB
[&=] Pictures % Default.rdp 4/28/201911:20 AM  Remote Desktop ... OKBE
B videos @ Sudents.accdb 9/3/2019 11:22 AM Microsoft Access ... 420 KB
2. Windows (C:) é test.flv 11/19/2018 11:00 ...  FLV Video File (VLC) 1,027 KB
i :
= Local Disk (D:)
=% Network e
File name: |test.fiv v | Al Files () v|
| Open I | Cancel |
File uploaded, click OK
; x
Upload Media
Choase a file Choose testiiv
[#| Cvenwrite existing files
Destination Library Site fssets v
OK Cance
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You get the below window that the file inserted successfully:

Test

0 replies

Mohamad Rabee O. Obeid

November 22, 20 Reply Edit

Editing Discussion
To edit a discussion, do the following:

1. Onthe left Tools menu, click Discussion Board.

2. Click the name of the necessary discussion board.

3. Click the discussion name or the down arrow next to it and select Edit Item from the drop-
down list.

4. Modify the discussion as necessary.

5. Save the changes.

Deleting Discussion
To delete a discussion, do the following:

1. Click the Discussion Board item in the left Tools menu.

2. Click the name of the necessary discussion board

3. Point over the necessary discussion and press the down arrow in the appeared box.

4. Click the discussion name or the down arrow next to it and select Delete Item from the
drop-down list.

5. Confirm the deletion.
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Viewing and Posting Replies

To read replies posted for a certain topic or post your own replies, do the following:

1. Onthe left Tools menu, click Discussion Board.

2. Click the discussion board name or the down arrow next to it and select View Discussion
Board from the drop-down list. OR simply click the discussion board name. The list of
discussions will be opened.

TIP: Column names at the top of the list are clickable and allow you to sort announcements in
ascending or descending order:

e Use the Subject link to sort or filter replies by subject;
e Use the Created By link to sort or filter replies by author;
e Use the Last Updated link to sort or filter replies by the last updated date;

e To remove filter criteria, click the column name and select Clear filter from option from
the context menu.

3. Click the necessary discussion from the list. The system will open discussion details
page.

First Lecture

1 rephy

Teacher 1
Yesturday we had the first lecture. I'd like to know your opinion on it.

go Reply Edit

LS O

(%))

NOTE: Note that if corresponded permissions are granted to you, you may have an ability to
manage discussion replies. To do so, click the View Properties link next to the required reply
and choose whether to create a new reply, edit or delete the reply, or work with notification
settings.

4. To reply to a certain post, click the Reply link under the post, or just enter your reply in
the Add a reply field with the help of the Visual Editor, attach a file if needed and save
changes:
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BROWSE FORMAT TEXT ‘ INSERT || LIST
— N A AJ ABC

— & V =f=
Clipboard Font  Paragraph Styles Speling Markup

<

Styles Speliing

Y

Tools First Lecture §
Announcements
& ireply
FE] Calendar
Documents
& Teacher 1
el Yesturday we had the first lecture, I'd like to know your opinion on it.
@& Chat 26 minutes ago  Reply Alert me
= Mailbozx
The lecture was very useful, but the tempo was rather quick. Could you talk a little bit slower?|

& Links

& Learning Path

o] Quizzes

[£3 Drop Box

IET Helpdesk Contacts:

Phone number: 22060299

Email: helpdesk@ac-kuwait.edu.kw
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